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1 Introduction
This document provides installation and setup instructions for Release 1.0.0.6 (R1.0.0.6) of Processor
Audio SDK (PASDK) 1.0 for K2G provided by Texas Instruments, Inc. (Tl). R1.0.0.6 incorporates
several packages: (1) the Open Source (0S) package; (2) the Firmware Deliverable (FD) package; (3)
the Dolby Atmos IP package; and (4) the DTS DTSX IP package. The R1.0.0.6 features provided by
these packages are detailed below.

1. OS package
e Audio input drivers: HDMI input, and 8-channel ADC or S/PDIF (optical only) input.
e Audio output drivers: up to 16-channel DAC output.
e Control I/O drivers: UART, SPI and 12C.
e PCM decoder.
e PCM encoder with DEL and VOL ASP phases.
e DEL3, DM, FIL, SRC, MLO and AEO ASP’s.
e Framework supporting I-topology, with decoders executing on ARM and ASP’s
executing on DSP.
2. FD package
e SNG decoder.
e BM2, DEM and GEQ3 ASP’s.
3. Dolby Atmos IP packages
e Dolby Intrinsics 1.8.1.1.
e Dolby Digital Plus (DDP) decoder 4.7.2.
e Metadata-enhanced Audio Transmission (MAT) decoder 2.1.2.
e TrueHD (THD) decoder 3.3.3.
e Channel Audio Renderer (CAR) 1.0.0.
e Object Audio Renderer (OAR) 1.0.0 & Object Audio Renderer Interface (OARI) 1.1.11
from SIDK 1.3.
e Bass Management (BMDA) from SIDK 1.3.
4. DTS DTSX IP packages
e DTSX/PARMA 3.90.50.1.

2 Required Hardware
The hardware listed below is required for complete R1.0.0.6 functionality:

1. Mistral K2G Rev. D EVM (SPRW274).
2. Mistral K2G EVM Audio Daughter Card Rev. B (SPRW279).
3. Momentum Data Systems (MDS) HDMI repeater kit, including:
e  MDS HSR41P HDMI Repeater module Rev. A.
e MDS DA10X Interface board (IFB) Rev. A.
e 5V ACto USB power supply for IFB and HSR41P.
e Short 26- and 34-wire ribbon cables for connecting HSR41P and IFB.
e Long 34-wire ribbon cable for connecting IFB and Audio Daughter Card.
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4. MPC-HC player.
e Itis used to stream DTS streams to K2G EVM via HDMI from Windows PC.
e The MPC-HC installer can be downloaded at: https://mpc-hc.org/downloads/
e The detailed test setup and integration information can be found in APPENDIX A.

3 Software Installation

3.1 Code Composer Studio (CCS)
R1.0.0.6 was developed using CCS versions 6.1.2.00015 and 7.1.0.00016 on Windows. Download the
Off-line Installers for these versions of CCS at the following URLs:

http://processors.wiki.ti.com/index.php/Download CCS#Code Composer Studio Version 6 Downl
oads

http://processors.wiki.ti.com/index.php/Download CCS#Code Composer Studio Version 7 Downl

oads
Install CCS 6.1.2 to C:\ti. During CCS installation:

e For “Processor Support”, select “Multi Core Processors (all)”
e For “Select Debug Probes”, select “TI XDS Debug Probe Support” and “Spectrum Digital
Debug Probes and Boards”

Install CCS 7.1.0 to C:\ti. During CCS installation:

e For "Processor Support", select "66AK2x multicore DSP + ARM Processors & C66x Keystone
multicore DSP"
o For "Select Debug Probes", select "Spectrum Digital Probes and Boards"

R1.0.0.6 was developed using the code generation tools listed below.

e GNU ARM Tools 4.8.0.201493-20140805 (installed as part of CCS 6.1.2).

e (C6000 v8 Compiler Tools: 8.1.0 (installed as part of CCS 6.1.2).

e (C6000 v7 Compiler Tools: 7.4.4. (Only used to build DTSX Parma libraries. The Installer can
be downloaded at http://software-dl.ti.com/codegen/non-esd/downloads/download.htm).

3.2 Processor SDK-RTOS

R1.0.0.6 was developed using Processor SDK-RTOS 4.0.0.4 for K2G on Windows. Release information
for this version of Processor SDK-RTOS is provided at the URL below, along with a link to the
installer:

http://software-dl.ti.com/processor-sdk-rtos/esd/K2G/04 00 00 04/index FDS.html

Install all components of Processor SDK-RTOS to C:\ti. Among others, this will install the tools in the
following list:


https://mpc-hc.org/downloads/
http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Version_6_Downloads
http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Version_6_Downloads
http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Version_7_Downloads
http://processors.wiki.ti.com/index.php/Download_CCS#Code_Composer_Studio_Version_7_Downloads
http://software-dl.ti.com/codegen/non-esd/downloads/download.htm
http://software-dl.ti.com/processor-sdk-rtos/esd/K2G/04_00_00_04/index_FDS.html
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e SYS/BIOS 6.46.05.55
e XDAIS 7.24.00.04
e XDCTools 3.32.01.22

3.3 Open Source Package
The R1.0.0.6 OS package is distributed using a self-extracting executable. Follow the steps below to
install the software.

1. Double click the executable to initiate the installation process. Continue to the License
Agreement.

2. Accept the terms of the click-wrap license agreement.

3. Change the installation destination folder if desired, or accept the default c:\ti\processor_
sdk_audio_1 00 _00 06 in the Choose Destination Location window. Complete the
installation.

Upon completion of the installation, the installation root folder (<pasdk_root>) contains the sub-
folders described in the table below.

Folder Contents
docs\ User documentation
pasdk\ PASDK OS Dev (paf\)

ARM application (common), shared), test_arm)\
DSP application (common), shared\, test_dsp\)
psdk_cust\ | Library Architecture and Framework
(libarch_k2g_1_0_1_0\)

scripts\ Build scripts

tools\ Alpha communication tools

3.4 Firmware Deliverable Package

The R1.0.0.6 FD package is distributed as a .zip archive. To install the software, unzip the package
.zip file to <pasdk_root>\pasdk\paf. The FD package root folder is “pa”, so unzipping the file should
overwrite the pa folder in paf and overwrite or create the sub-folders described in the table below.

Folder Contents

pa\asp ASP IP (bm2, dem, geq3) header files

pa\build Decoder and ASP IP libraries for ARM (sngl) and DSP
(bm2, dem, geq3)

pa\dec Decoder IP (sngl) header files

pa\docs User documentation

3.5 Dolby IP Packages
The R1.0.0.6 Dolby IP packages are distributed using a select-extracting executable. Follow the steps
below to install the software.

1. Double click the executable to initiate the installation process. Continue to the License
Agreement.
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Accept the terms of the click-wrap license agreement.

Accept the default installation folder, or change the folder to the desired location of the
Dolby IP packages (e.g. <pasdk_root>\release\dhip_package). Complete the installation.
Upon completion of the installation, unzip all Dolby IP .zip packages (bmda, car, oar, ddp,
intrinsics, matthd, and oar) to <pasdk_root>\dolby_ip\dh-ip. After unzipping the Dolby IP
.zip packages, the dh-ip folder should contain the sub-folders described in the table below.

Folder Contents

asp\ ASP IP (bmda, car, oar) header files

build\ IP libraries for ARM (ddp, mat, thd) and DSP (bmda, car,
instrinsics, oar)

dec\ Decoder IP (ddp, mat-thd) header files

DOC\ User documentation

3.6 DTSIP Packages
The R1.0.0.6 DTS IP packages are distributed using a select-extracting executable. Follow the steps
below to install the software.

1.

Double click the executable to initiate the installation process. Continue to the License
Agreement.

Accept the terms of the click-wrap license agreement.

Accept the default installation folder, or change the folder to the desired location of the DTS
IP packages (e.g. <pasdk_root>\release\dtsip_package). Complete the installation.

Upon completion of the installation, the unzip dtsx and parma .zip packages to
<pasdk_root>\3p-ip-dts\dtsx-ip. After unzipping .zip packages, the dtsx-ip folder should
contain the sub-folders described in the table below.

Folder Contents

asp\ ASP IP (parma) header files

build\ IP libraries for ARM (dtsx) and DSP (parma)

dec\ Decoder IP (dtsx) header files

DOC\ User documentation

3.7 CCS Update
Update the CCS 7.1.0 installation as below:

Launch CCS and create a new workspace (e.g. <pasdk_root>\pasdk\workspace_pasdk).
Allow installation of newly discovered products located in c:\ti.

e Ignore any messages about unsigned content

e Restart CCS when prompted
Update Tools discovery path to access C6000 CGT 8.1.0 and ARM Tools 4.8.0.2014q3-
20140805.

e Select Window—Preferences

o Select Code Composer Studio—Build—Compilers

e (Click Add next to Product Discovery Path, add folder c:/ti/ccsv6/tools/compiler
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3.8 PASDK OS Dev Build and Alpha Communication Tools

Download and install the additional tools below. Sed and Python are required to build the PASDK OS
DEV software contained in the <pasdk_root>\pasdk\paf folder. Python is also required for alpha
command control I/0O over using the PyAlpha tool. The PyAlpha tool is further described below in
Section 6.4.

1. Obtain Sed 4.2.1 from http://gnuwin32.sourceforge.net/packages/sed.htm,
executable installer, sed-4.2.1-setup.exe.

Install to c:\PA_Tools\GnuWin32 (or change installation location in
<pasdk_root>\pasdk\setup_env.bat).

2. Obtain Python 2.7.6 from https://www.python.org/download/releases/2.7.6
executable installer, python-2.7.6.amd64.msi.

Install to c:\PA_Tools\Python27 (or change installation location in
<pasdk_root>\pasdk\setup_env.bat).

3. Once Python is installed, run <pasdk_root>\scripts\setup_env.bat and then navigate to
<pasdk_root>\tools\ and run setup.bat to install PyAlpha dependencies.

4 Emulator Firmware Update
The K2G EVM on-board emulator firmware must be updated for correct emulator operation. Update
the firmware as described below.

1. Connect the EVM to the host PC using the provided USB Mini B to A plug type cable. Connect
the Mini B plug on the cable to XDS_USB connector J1 on the EVM.

2. Connect the EVM to power using the supplied 12V power supply.
Apply power to the EVM by pushing the SW1 switch to the “ON” position.

4. Open a DOS prompt on the PC. At the DOS prompt, issue these commands:

> cd c:\ti\ccsv6o\cecs base\common\uscif\xds2xx
> update xds2xx.bat xds200

5. The batch file output should appear as shown below.
Updating CPLD ...

Updating Firmware ...

éebooting ..

Reading Configuration ...

éheck swRev is 1.0.0.8 or higher

boardRev=4
ipAddress=0.0.0.0
ipConfig=dhcp
ipGateway=0.0.0.0
ipNetmask=0.0.0.0
productClass=XDS2XX
productName=XDS200


http://gnuwin32.sourceforge.net/packages/sed.htm
https://www.python.org/download/releases/2.7.6
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serialNum=00:0E:99:03:90:0F
swRev=1.0.0.8
hostCPU=AM1802
emuCtrlType=Bit bang
extMemType=SDRAM
portUSB=true
pPortENET=false
portWIFI=false
portRS232=false
EnableUSBSerial=false
CurrentMeasure=false

Press any key to continue .

5 Software Build

5.1 PASDK OS Dev Libraries

The ARM and DSP applications depend on several libraries located in the <pasdk_root>\pasdk\paf
folder. Detailed instructions for building any of the libraries in this folder are contained in
<pasdk_root>\pasdk\paf\ReadMe.txt. However, batch files for building only the necessary libraries
for the ARM/DSP applications are provided in the <pasdk_root>\scripts folder. To build the required

libraries:

Open a DOS prompt.
From the DOS prompt in <pasdk_root>, execute:
> cd scripts

> setup_ env.bat
> build paf libs.bat

5.2 DSP Application
To build the DSP application:

1.

Import the “test_dsp” CCS project into the CCS workspace. The project is located in
<pasdk_rooot>\pasdk\test_dsp.
Select the desired build configuration
e For Dolby Harmony: right-click test_dsp project in CCS Project Explorer, select Build
Configurations—Set Active—Project—Debug_DH_IPPkgs.
e For DTS:X: right-click test_dsp project in CCS Project Explorer, select Build
Configurations—Set Active—Project— Debug_DTSX_IPPkgs.
Ensure the correct component software versions are selected in the RTSC control panel (See
Figure 1 below).
e Right-click test_dsp project in CCS Project Explorer, select Properties.
e On left-hand side of window, select General. Select RTSC tab on right-hand side of
General window.
e Confirm the following PrSDK 4.00.00.04 components are installed and selected:
1. SYS/BIOS 6.46.5.55.
2. System Analyzer (UIA Target) 2.0.6.52.

10
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XDAIS 7.24.0.04.
DSPLIB C66x 3.4.0.0.
IPC 3.46.00.02.
EDMA3 LLD 2.12.4.
. k2g PDK 1.0.6.
e Click OK.
4. Rebuild the project using the selected build profile.

N o v w

e Right-click test_dsp project in CCS Project Explorer, select Rebuild Project.

v+ Properties for test_dsp =3 Eom (=)
type filter text 1, Platform name 'tiplatforms.evmTCIB6AKZG02:...d. Your project may not build as expected. (5 v -
Resource
General
4 Build Canfiquration: |Debug DH [ Active ] "|ManageCnr\ﬁguratinr\s..‘

a4 CR000 Cornpiler
Processor Options

Optimization ] Main | Bk RTIC
Include Options
Perfarmance Advisar XD Ctoaols version: | 3.32.1.22_core v|
Advanced Options
> CA000 Linker B Products and Repositories | & Qrder
CHO00 Hex Utility [Disabled] R
. ¥DCtoals =) CTools Library Add...
Diebug 4 [V I??PLIB Chfix o
Git 7] £ 3.4.0.0 Edit..
4[] i EDMAI Loww Lewvel Diriver

o Bemowve
7] 85 2124

£ 1

= Framework Carpanents Select All
=i IMGLIB Ctx Deselect Al
s [7] 54 IPC I—/

7] £ 246002

£ 3.43.0.00_eng

£ 342002
=, LibArch K26
= MATHLIB Cfix
= DK
B OpenhP Runtime 2 library
=, SYS/RIOS
7] £ 646555

=7 6.45.1.29
B System Analyzer (ULA Target)
7] £ 2.0.6.52

£ 20343
=i XDAIS
7] £ 124004
=), k2g PDK
7] £ 106

£ 10.L2_eng

=7 101
a [Vl Other Repositories

V] (# HTARGET_CONTEMNT_BASEY [Ciftifccawl/cos_base]

S
<

[N
<

[N
<

[N
<

Target: titargets.elf.Co6
Platforrn: ti.platforms evm TCI6RAK2G02:corel -
Build-profile: release -

'?)‘ Show advanced settings Cancel

Figure 1: DSP Application RTSC Configuration

5.3 ARM Application
To build the ARM application:

1. Import the “test_arm” CCS project into the CCS workspace. The project is located in
<pasdk_root>\pasdk\test_arm.
2. Select the desired build configuration
e For Dolby Harmony: right-click “test_arm” project in CCS Project Explorer, select
Build Configurations—Set Active—Project—>Debug_DH_IPPkgs.

11



Processor Audio SDK Setup Guide V0.70

e For DTS:X: right-click “test_arm” project in CCS Project Explorer, select Build
Configurations—Set Active—Project—>Debug_DTSX_IPPkgs.
3. Ensure the correct component software versions are selected in the RTSC control panel (See
Figure 2 below).
e Right-click test_arm project in CCS Project Explorer, select Properties.
e On left-hand side of window, select “General”. Select RTSC tab on right-hand side of
General window.
e Confirm the following PrSDK 2.00.02.11 components are installed and selected:
1. SYS/BIOS 6.46.5.55.
2. System Analyzer (UIA Target) 2.0.6.52.
3. XDAIS 7.24.0.04.
4. |IPC 3.46.00.02
e C(Click OK.
4. Rebuild the project using the selected build profile.
e Right-click test_arm project in CCS Project Explorer, select Rebuild Project.

+'s Properties for test_arm o |[[E ]
fype filter text 1, Platform name ‘tiplatforms.evrn TCIORAK2G02, .. Your project may not build as expected. =14 - -
Resaurce
General
+ Build Corfiguration: | Debug_DH_IPPkas [ Active ] ~| [Manage Configurations..
4 G Campiler
Runtime
Symbals = Main | B RTSC
Directories
Optirnization HDCtools version: 332122 core -
Preprncessor
Assembler =i Products and Repositaries | %% Order
Debugging i —
Diagnostic Options B\ CTools Library add., |
Miscellaneous B DSPLIB C66x
SNU Linker =4 EDMA3 Low Level Driver Edit..
GHU Ohjeapy Utility [Disabled] Bk Framework Components Rermove
¥DCtools = IMAGLIE Cobx =
Debug 4 [FEA PPC " celectal |
Git 7] & 3.46.0.02 | selectan |
& 343000 eng [ Deselectan |
£ 342002 ——
=) Libdrch K26
= MATHLIE Cox
=) NDK
=) OpenhP Runtime 3. library
4 [7]Eh SYSEIOS
7 5 6.45.5.55
£ 545120
4 [F]Eh Systern Analyzer (LA Target)
7] % 20652
520343
4+ [7]mh ¥DAIS
7% 134004
= k2g PDK
4 [7]7g Other Repnsitaries
7] (% HTARGET COMTENT BASE} [Cifti/ccnfocs base]
Target: g targets.s e A15F
Platform: ti.platforms.ewm TCIREAKIG02thost -
Build-profile: release -
() show advanced settings [ cancel

Figure 2: ARM Application RTSC Configuration

6 Application Execution and Test

6.1 1/0 Configuration

12
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R1.0.0.6 supports boot- and run-time 1/O configuration. Boot-time |/O configuration is determined
by the at-boot I/O shortcuts in the CUS_ATBOOT _S definition in
<pasdk_root>\pasdk\test_dsp\application\itopo\evmk2g\atboot.c, while run-time 1/O configuration
is performed by invoking I/O shortcuts via alpha commands. The available Input and Output
shortcuts are defined in <pasdk_root>\pasdk\test_dsp\application\itopo\evmk2g\io.c and described
in the tables below.

Input Configuration Input Shortcut

ADC 8-ch execPAllnAnalog

(w/ DAC 8-ch input)

S/PDIF execPAlInDigital
Stereo HDMI execPAIHDMIInStereo
(PCM or DDP)

HDMI execPAIInHDMI

(MAT-THD/PCM)

Output Configuration | Output Shortcut

DAC 8-ch execPAlOutAnalogSlave
(w/ ADC 8-ch input)

DAC (8-ch) execPAlOutAnalog

DAC (12-ch) execPAlIOutAnalog12Ch
DAC (16-ch) execPAlIOutAnalog16Ch

6.2 Connect EVM
1. Turn off power to the EVM using SW1 on the EVM. Disconnect the 12V power supply.
Assemble the Audio Daughter Card (assembly instructions are packaged with Audio
Daughter Card).
3. Attach the Audio Daughter Card to the K2G EVM. The Audio Daughter Card connects to the
EVM through the JP1 “Audio Expansion” and J12 “Serial Expansion” connectors on EVM.
4. Connect the PC and K2G EVM using DB9 serial RS-232 cable delivered with EVM.
e A USB to UART FTDI cable can be used on the PC side of the connection.
e Attach the DB9 connector to the P1 “UART0” connector on the EVM.
e Push the SW12-UARTO_DB9_EN switch to the “ON” position.
5. Connect the EVM emulation port to the PC as described in Section 4.
6. Connect the MDS HSR41P to the MDS IFB.
e Connect HSR41P J4 “Main” header to the IFB J5 “Main” header using the short 26-
wire ribbon cable. Ensure the red wire on the ribbon cable is connected between
HSR41P J4 Pinl and IFB J5 Pin1.

13
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e Connect HSR41P J7 “Sec” header to the IFB J2 “Sec” header using the short 34-wire
ribbon cable. Ensure the red wire on the ribbon cable is connected between HSR41P
J7 Pinl and IFB J2 Pin1.

7. Connect the MDS IFB to the Audio Daughter Card. Connect IFB J3 “McASP0” header to Audio
Daughter Card “12S Header” using the supplied long 34-wire ribbon cable. Ensure the red
wire on the ribbon cable is connected between IFB J3 Pinl and Audio Daughter Card “I2S
Header” Pinl (note the “12S Header” is only 32 pins, so the two wires on the ribbon cable
opposite Pinl are unused).

8. Connect HDMI cable from audio source (e.g. Blu-ray player) to HSR41P J6 “IN”. Connect
HDMI cable to audio sink (e.g. HDMI enabled monitor) from HSR41P J8 “HDMI OUT”.

9. Connect 5V AC to USB power supply to IFB power connector J1.

10. Re-connect the 12V power supply to the EVM. Turn on power to the EVM using SW1.

6.2.1 ADC 8-Ch Input and DAC 8-Ch Output
Connect ADC inputs to the ADC_INO-3 input jacks on the Audio Daughter Card. Processed PCM
samples will be output to the corresponding DAC output jacks DAC_OUTO-3 on the Daughter Card.

6.2.2 S/PDIF Input and DAC 8-Ch Output
Connect S/PDIF input to the MOD1 Digital Input (Optical) connector on the Audio Daughter Card.
Processed PCM samples will be output to the DAC output jacks DAC_OUTO-3 on the Daughter Card.

6.2.3 HDMI Input and DAC Output

Connect HDMI input source to the HSR41P repeater module as described above. Processed PCM
samples will be output to DAC output jacks DAC_OUTO-6 on the Daughter Card. The number of
active DAC outputs depends on: (1) the selected Output Shortcut (execPAIOutAnalog,
execPAlOutAnalog12Ch, or execPAlOutAnalog16Ch); (2) the configured ENC channel map from; and
(3) the active renderer channel configuration request. For example, issue the alpha commands listed
below to enable 12-channel DAC for channel-based audio using CAR with speaker layout L/R, C, Sub,
Ls/Rs, Lrs/Rrs, Ltf/Rtf, Ltr/Rtr:

CMD> python pyalpha execPAIOutAnalogl2Ch
alpha execPAIOutAnalogl2Ch

CMD> python pyalpha
writeENCChannelMapFromlé (PAF_LEFT,PAF RGHT,PAF_LSUR,PAF RSUR,PAF CNTR,PAF SUBW,PAF LBA
K,PAF_RBAK,PAF LTFT,PAF RTFT,PAF LTRR,PAF RTRR,-3,-3,-3,-3)

CMD> python pyalpha writeSYSChannelConfigurationRequestSurround4LtfRtfLtrRtr_ 1
alpha /* none */

CMD> python pyalpha readCARChannelCfgOverride
alpha writeCARChannelCfgOverrideUnknown

6.3 Load and Execute Code
Follow the steps below from within CCS to load and execute the DSP and ARM application code:

Click View—Target Configurations.

In the Target Configurations window, open the Projects—test_dsp—targetConfigs folder.
Right-click on K2GEVM.ccxml contained in the targetConfigs folder.

Select Launch Selected Configuration.

el S

14
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In the Debug window, right-click on the C66x and select Connect Target. The output from
the GEL code invoked on the target connection can be observed in the Console output
window. The final line of this output should read “"C66xx: GEL Output: DDR3A
initialization complete”.

In the Debug window, right-click on the CortexA15 and select Connect Target. The output
from the GEL code invoked on the target connection can be observed in the Console output
window. The final line of this output should read “CortexA15: GEL Output: AlS5
non secure mode entered”.

In the Debug Window, click on the C66x and then open Run—Load—Load Program. In the
Load Program window, click on Browse project, open the “test_dsp” folder, and click on
“test_dsp.out” and OK to select the program to be loaded. Click on OK in the Load Program
window to load the program to the C66x.

In the Debug Window, click on the CortexA15, and then open Run—Load—Load Program. In
the Load Program window, click on Browse project, open the “test_arm” folder, and click on
“test_arm.out” and OK to select the program to be loaded. Click on OK in the Load Program
window to load the program to the A15.

In the Debug window, click on the C66x and then Open Run—>Resume to execute the DSP
code.

10. In the Debug window, click on the CortexA15 and then Open Run—>Resume to execute the
ARM code.

11. The CIO Console output window should display memory usage statistics. The final line of
output should display the memory usage summary for the EXT NC SHM heap.

6.4 PyAlpha Python Scripts for Alpha Communication
R1.0.0.6 supports alpha command control over UART using the PyAlpha tool located in
<pasdk_root>\tools. PyAlpha is invoked on the command-line in a DOS shell. PyAlpha

documentation can be obtained by executing PyAlpha with a “--help” argument as below (note: the

Python executable is contained in the DOS shell path for this example).

> T:

> cd tools

> python pyalpha --help

usage: PyAlpha [-?] [-h FILE] [-I DIR] [-p PORT] [-b BAUD] [-t DIR] [-bin DIR]

[-r] [-s] [-—-fast] [--repeat N T N T] [-log LEVEL]
[ALPHAS [ALPHAS ...]]

Alpha Command Communicator

positional arguments:
ALPHAS Alpha commands, separated by spaces

optional arguments:

-?, --help show this help message and exit

-h FILE, --header FILE
Add FILE a.h to symbol definition list and FILE a.hdM
to symbol decomposition list

-I DIR, --include DIR
Add DIR to the include path. [default: ./alpha]

-p PORT, --port PORT Communication port [default: COM1]

-b BAUD, --baud BAUD Baud rate [default: 19200]

-t DIR, --temp DIR Temporary file save location [default: .]

-bin DIR Binary file location [default: ./bin]

-r, --retain Retain temporary files

-s, —-—-session Run a PyAlpha session, retains startup settings
--fast Skip post-processing

15
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--repeat N T N T Repeat an alpha command N times with a T second break
between
-log LEVEL, --loglevel LEVEL

Set log level

The file <tools>\config_cust.ini is used to configure default settings for PyAlpha and should be
edited to reflect your system (these configurations can be overwritten with CLI flags).

When running PyAlpha with the —s flag, you can use tab-completion once 3 or more characters are
typed into the console.

6.5 Alpha Commands for AEQ Configuration/Status

R1.0.0.6 includes the Audio Example O (AEQ) ASP. This ASP transforms stereo (Left/Right) PCM into
3stereo (Left/Right/Center) PCM. AEOQ can be included in the signal chain by defining the _AEOQ_
macro in <pasdk_root>\pasdk\test_dsp\framework\itopo\patchs.c and rebuilding the DSP
application. AEO documentation is provided in <pasdk_root>\docs\DA10x_UG_AspExample.pdf, and
the alpha commands contained in <pasdk_root>\tools\alpha\ae_a.h can be used to configure AEO
and consult AEO status.

In the example alpha command sequence below, AEOQ is configured to generate 3stereo using a gain
of 0.5 (16384 in $16Q15 format) using COM port 1. After disabling AEOQ, the Master Volume Control
is set to -20 (= 40*0.5 dB).

(Note: ‘CMD>’ indicates the commands issued from a DOS shell and *>’ indicates commands from a PyAlpha session).

CMD> T:

CMD> cd tools

CMD> python pyalpha --session

> readAEMode

alpha writeAEModeDisable

> writeAEModeEnable

alpha /* none */

> readAEMode

alpha writeAEModeEnable

> readAEScaleQl5

alpha wroteAEScaleQl5,0x0000

> writeAEScaleQl5(16384)

alpha

> readAEScaleQl5

alpha wroteAEScaleQl5,0x4000

> readSYSChannelConfigurationRequest

alpha Oxce20,0x2008,0x010c, 0x0000,0x0000,0x0000
> writeSYSChannelConfigurationRequestStereo
alpha /* none */

> readSYSChannelConfigurationRequest

alpha Oxce20,0x2008,0x0003,0x0000,0x0000,0x0000
> writeSYSChannelConfigurationRequestSurround4 1
alpha /* none */

> readSYSChannelConfigurationRequest

alpha Oxce20,0x2008,0x010c,0x0000,0x0000,0x0000
> writeAEModeDisable

alpha /* none */

> readAEMode

alpha writeAEModeDisable

> writeVOLControlMasterN (-40)

alpha /* none */
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7 APPENDIX A: DTSX Test Setup and Integration

7.1 Test Setup
MPC-HC player is used to stream DTS streams to K2G EVM via HDMI from Windows PC. The MPC-HC
installer can be downloaded at: https://mpc-hc.org/downloads/.

Once MPC-HP player is installed, follow the following setup steps:

1. GOTO options in View menu:

5] BDO1-LinSwp0-4824-1509k 51.dt.. L] . [

File |View | Play MNavigate Favorites Help

Hide Menu Ctrl+0
v SeekBar Ctrl+1
v Controls Ctrl+2
¥ Information Ctrl+3
v | Statistics Ctrl+4
¥ Status Ctrl+5
Subresync Ctrl+6
Playlist Ctrl+7
Capture Ctrl+8
Mavigation Ctrl+9
Debug Shaders
m Presets... 3
— Full Screen Alt+Enter
Zoom 3
Renderer Settings 3
Video Frame 3
PanéiScan 3
On Top 4
Options... o]

2. Select Internal Filters > Audio Decoder:
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"Options e | C)
4-Player Internal Filters
- Formats ' )
If you would like to use the stand-alone versions of these filters or another replacement,
- Keys disable them here,
--Logo Source Filters Transform Filters
.. Web Interface vl i AAC i
4 Playback Avisynth N AC3/E-AC3/TrueHDMLP I
- DVD/OGM CDDA (Audio CD) DTS
- Output CDXA (VCD/SVCD/XCD) LPCM 3
- Shaders DirectShow Media = MPEG Audio
- Fullscreen AC3 Varbis
- Sync Renderer Settings OTS/DTS-HD FLAC
- Capture DVD Video Tite Set Nellymoser
4 |Internal Filters | FLIfFLC ALAC
- Audio Switcher FLAC ALS
... Audio Renderer FLV AMR
. External Filters GIF Opus
4 Subtitles Matroska RealAudio
i... Default Style MP4MOV P52 Audio (PCM/ADPCM)
..... Misc MPEG Audio Other PCM/ADPCM
- Tweaks [V] MPEG PSITS/PVA k¥4 [V] MPEG-1 Video k¥4
- Miscellaneous Internal LAV Filters settings
- Advanced [ Splitter ] ’ Video decoder ] ’ Audio decoder
[ OK ] [ Cancel Apply

3. Make the setting as shown below:

r

Properties

Audio Settings | Mixing

Dynamic Range Compression
[ Apply DRC on formats that support it {(AC3, EAC3)

Level: 100%:
Bitstreaming (S/POIF, HOMI)
Formats
|| Dolby Digital (AC-3) OTS
[ Dolby Digital Plus (E-AC3) DT5-HD
[ Dolby TrueHD
Options

[ Use OTS-HD Framing for all 0TS types
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4. Select Audio Renderer, make sure it is System Default:

- Miscellaneocus
. Advanced

' -  — B
Opti
ptions . - g
- Player Audio Renderer
-- Formats
Device
- Keys
- Logo [system Default -
- Web Interface
4 - Playback [ Exdusive mode Allow bitstreaming
. VDY OGM
- Qutput Options
- Shaders
- Fullscreen [T] Enable steren crossfeed (for headphones)
- Sync Renderer Settings - Cut-off: 700 Hz
C. Moy J. Meier
- Capture Level: 6.0 dB
4 -Internal Filters
i Audio Switcher
.| Audio Renderer | Mote
- To minimize udio distortion, it is recommended to keep player volume at around
Exter.rlal Filters 85% when playing loud Iossry-enooded content.
4 - Subtitles
.. Default Style
i Misc
- Tweaks

[ Ok ] [ Cancel Apply
L — =
5. Select Output, make sure it is System Default:
i = s W W — B
Options u
P ee— Y e
4 Player Qutput
Eormats DirectShow Video
- Keys
.. Logo [Enhanced Video Renderer v]
- Web Interface o DXVA o Subtitles " Screenshot 3§ Shaders  J€ Rotation
- Play[?;[c::roﬁm RealMedia Video QuickTime Video
|m| [System Default v] [Svstem Default V]
... Shaders ¥ subtitles K screenshot H subtitles ¥ screenshot
- Fullscreen Audio Renderer
- Sync Renderer Settings [1_ System Default ‘]
- Capture :
4 -Internal Filters Subtitle Renderer
- Audio Switcher VSFilter / DirectvobSub
i Audio Renderer
.. Bxternal Filters WMR-7/VMR-9 (renderless) and EVR (CP) settings
Select D309 Render Device
VMR-2 Mixer Mode
- Surface: | 3D surfaces (recommended)
YUV Mixing
- Tweaks Alternative VSync Resizer: |Bilinear
- Miscellaneous D3D Fullscreen S z
uffers:
- Advanced Reinitialize when changing display
[ ok || cancel Apply
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7.2 Integration
DTSX decoder is integrated on K2G ARM core and PARMA is integrated on K2G C66x core.

7.2.1 DTSX Decoder Integration on K2G ARM Core

1. Get DTSX decoder component libraries from DTSX IP release package:

o dts-3d.lib

o dts-base.lib

o dts-flib.lib

e dts-lbr.lib

e dts-lbr-dec.lib

e dts-parma-dec.lib
e dtsx-c-decoder.lib

la-strm-reconstruction.lib
e dts-alg.lib

2. Modify patchs.c on ARM to include DTSX decoder into the system.

#define _DTS_

#ifdef DTS_

#include <dtsuhda.h>

#include <dtsuhda_tid.h>

#endif

const PAF_ASP_LinkInit decLinkInitl13[] =

{
PAF_ASP_LINKINIT(STD, PCM, MDS),

#ifdef DTS_
PAF_ASP_LINKINIT(STD, DTSUHDA, TID),
#endif

PAF_ASP_LINKNONE,
b

3. Modify .cmd file to link the DTSX libraries into a build.
For example, copy all the libraries in C:\ti\processor_sdk_audio_1_00_00_06\3p-ip-dts\dtsx-
ip\build\al5\release\ folder and add the following lines in .cmd.

SEARCH_DIR ( C:\ti\processor_sdk_audio_1_00_00_06\3p-ip-dts\dtsx-ip\build\al5\release )

INPUT ( dts-3d.lib dts-base.lib dts-flib.lib dts-lbr.lib dts-Ibr-dec.lib dts-parma-dec.lib dtsx-c-decoder.lib
la-strm-reconstruction.lib dts-alg.lib )

4. Add the path to DTSX header files in CCS Project Directories
For Example:
"S{PROC_AUDIO_SDK_ROOT}/3p-ip-dts/dtsx-ip/dec/rel/dtsx/alg"
"S{PROC_AUDIO_SDK_ROOT}/3p-ip-dts/dtsx-ip/dec/rel/dtsx/alpha"
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7.2.2 PARMA Integration on K2G Cé6x Core

1. Get PARMA component libraries from DTSX IP release package.

e dts-3d.lib

o dts-base.lib

o dts-flib.lib

o dts-lbr.lib

e dts-lbr-dec.lib

e dts-parma-dec.lib

dtsx-c-decoder.lib
la-strm-reconstruction.lib
e dts-alg.lib

2. Modify patchs.c on DSP to include PARMA into the system.

#define _DTS_

#ifdef DTS_

#include <dtsuhdb.h>

#include <dtsuhdb_mds.h>

#endif

const PAF_ASP_LinkInit aspLinkInitAlll13[] =
{

#ifdef DTS_
PAF_ASP_LINKINIT(STD, DTSUHDB, MDS),
#endif
PAF_ASP_LINKNONE,
|3

3. Modify .cmd file to link the PARMA libraries into a build.
For example, copy all the libraries in C:\ti\processor_sdk_audio_1_00_00_06\3p-ip-dts\dtsx-
ip\build\c66x\release\ folder and add the following lines in .cmd.

-i"C:\ti\processor_sdk_audio_1_00_00_06\3p-ip-dts\dtsx-ip\build\c66x\release"

-I"dts-3d.lib"

-I"dts-base.lib"

-I"dts-flib.lib"

-I"dts-lbr.lib"
-I"dts-lbr-dec.lib"
-I"dts-parma-dec.lib"
-I"dtsx-c-decoder.lib"
-I"la-strm-reconstruction.lib"
-I"dts-alg.lib"

4. Add the path to PARMA header files in CCS Project Directories
For Example:
"S{PROC_AUDIO_SDK_ROOT}/3p-ip-dts/dtsx-ip/asp/rel/parma/alg"
"S{PROC_AUDIO_SDK_ROOT}/3p-ip-dts/dtsx-ip/asp/rel/parma/alpha"
"S{PROC_AUDIO_SDK_ROOT}/3p-ip-dts/dtsx-ip/dec/rel/dtsx/alg"
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"S{PROC_AUDIO_SDK_ROOT}/3p-ip-dts/dtsx-ip/dec/rel/dtsx/alpha"

22



